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Project Healthcheck Checklist 

Areas to be covered during the Healthcheck 

Please note that these may be adjusted to the focus of the healthcheck.

Project description - include background, size (cost, revenue, man days), time-frames (including major milestone dates), client expectations, assumptions, key milestones, major deliverables, dependencies internal and external to the project, and resourcing.

Project documentation - contractual position (fixed price/time and materials/time hire), deliverables/services, terms and conditions, project baseline, statement of requirements, objectives, proposal, clarification documentation, plans and deliverables.

Project organization (Consulting) - structure, organization, key staff, resource plan (including commitments versus requirements versus actual), understanding of requirements, terms of reference, roles/responsibilities, lines of communication, planned absences (training, holiday etc.) and staff schedules.

Third parties - role/responsibilities (names, roles), contractual agreement, dependencies, structure, deliverables and plans.

Sub-contractors - role/responsibilities (names, roles), contractual agreement, terms of reference, relationship with client/consulting and deliverables.

Client - organization, key performance indicators and critical success factors documented, key staff (understanding of business objectives, roles/responsibilities, dependencies), steering group (organization, role/responsibilities, dependencies) and acceptance responsibility.

Environment/special requirements - hardware and network dependencies, telecommunications limitations, number of sites, dependencies on other projects, interfaces to other systems, integration (with what and how), technically demanding requirements and imposed performance criteria.

Current project status reports - most recent project status reports produced for the client/consulting.

Project plan - is it “realistic” and achievable (who says)?  Can any changes to the baseline plan be tracked, quantified and managed through change control.  Is this the same plan as approved at bid or included in the contract?  Are all the items which have been completed or started part of the agreed plan?  Have any activities been removed from the plan and are they documented?  Covered by/resulting from change controls?  Is it evident from the plan what work has been done?  Is it evident from elsewhere that work has been done / accomplished?  Has the plan been approved/accepted by both the client and consulting?  What are the planned activities for next period?  Do these meet what needs to be done?

Client deliverables - have we reviewed/accepted/tested them?  Do they meet requirements/expectations and have they been signed-off?

Measurements - effort planned versus effort used, explanations for variances, are the variances covered by change control or explained and/or accepted by the client?

Project risks - what are the risks and their likely impact?  Is the risk register up to date?  When were the risks last reviewed and by whom, what risks require management attention and who knows about them?  What is the status of each risk?  Have new risks been identified, evaluated and documented?  Have the older ones actually materialized?  Is there good evidence that senior client/consulting management respond (in a timely manner, or otherwise) when issues are escalated to them?

Project financials - current spend versus budget, forecast spend versus budget, unplanned expenditures, reasons for the over/under spend, cash flow analysis done, what can be recognized, what cannot and why?

Client relationship - attitude to consulting, the project, the project management relationship, account management, team relationships.

Next period’s activities - estimate to complete (revenue, cost and effort), risks, issues and actions.  Does the plan include all anticipated items to complete the assignment?  Are any items being added or deleted from the plan (using change control)?  Has any additional effort or cost been identified, measured and approved?  Are there any delivery date implications?  Have suitable resources been identified and allocated (including client)?  Acceptance strategy and plans prepared?  Is pre-production planning underway and is it available to the team?  Is training the client/transfer of information planned/in progress/complete?  Are the overall costs and delivery dates acceptable both to the client and consulting?

Post implementation support - what is included in the Contract?  Can this be provided by the local consulting subsidiary?

Additional information on the contents of the Healthcheck is available from the consulting organization.

Review Items

· Completed a comprehensive Statement of Work.

· Obtained written client approval of the Statement of Work.

· Completed and obtained client approval on a thorough Scope Statement.

· Detailed workplan has been completed with realistic level of effort estimates and resource assignments.

· Client approved resource plan for both consulting and client resources for the engagement is completed and accepted by the client and consulting.

· Client has accepted the detailed work breakdown structure for the engagement in concert with the published risk assessment and project scope statement.

· The initial Project Management Plan has been completed.

· The initial Quality Plan has been completed and reviewed by the project team.

· The Risk Mitigation Plan has been completed and reviewed by the project team with appropriate control processes established.

· A Configuration Management Plan has been developed and reviewed by the project team.

· The initial Finance Plan has been developed with appropriate controls and monitoring procedures established.

· Change Management procedures have been established.

· Issue Management policies have been implemented.

· Problem Management tracking has been initiated.

· Quality Management tasks have been completed.

· Project Status Reports are routinely produced.

· The project workplan and finance plan are regularly updated.

· Budget variances are documented as either issues or change control items.

· Regular project team leader meetings are conducted and minutes recorded.

· Regularly scheduled Executive Status meetings are conducted with the client with minutes recorded.

· The Project Manager reviews and approves all walkthroughs and deliverables.

Healthcheck Interview Questions

Background Information

The table below outlines some basic background information about the project that you should know/find in order to assess the health of the project.

Organization and Background
General Project Information
Focused Control





Project Profile
Implementation Type

# Concurrent Projects 

Interdependent Projects - 

Relationship with consultant 

Project or Program level - 

Implementation and Development Method - 

Quality Orientation - 

Technical Strength/weaknesses - Medium -


Background
Size (cost, revenue, man-days)

Time-frames (including major milestone dates)

Noteworthy features

security requirements (if any)

assumptions


Scope per project

client relationship and expectations

key milestones

major deliverables.



Consultant’s  Structure
organization, key staff

resource plan

understanding of requirements 

terms of reference

roles/responsibilities

lines of communication

International consultants

understanding of client’s business objectives

key strategies and objectives documented

role/responsibilities

dependencies 
Current Status
Milestones Reached

Architecture Type

General Risks


Account/Sales
Referenceability

Loyalty

Perception

Marketing

<Client Name> Organization

organization, key staff 

Decision makers
Supporters

Challenges

Sponsorship

Leadership

Steering Group

organization

role/responsibilities

dependencies

Culture

Communication

Supporting Structures

Shared Ownership
Financial Budget
Terms and Conditions
Support
Responsiveness

Value relative to support level

Third Parties
role/responsibilities

contractual agreement

dependencies

structure

deliverables

plans
Quality Management System
Review Number

Type
Education

Delivered on site or at Ed Centers



Sub-Contractors
role/responsibilities

contractual agreement

terms of reference

Products and Tools
Stability

Direct Support

Project Information

The table below outlines areas of investigation for the healthcheck.

Financial
Project Strategy
1. What are the project manager’s key strategies for success


Status Reports
1. has a project status report been produced for the client

2. has a project status report been produced for the consulting organization


Quality Matters

1. quality checks on deliverables

2. quality reviews of project

3. status of non-conformities


Management
Project Management Plan
1. are there any changes to the plan

2. are all the items which have been completed or started part of the agreed plan

3. have any activities been removed from plan

4. have these been covered by or resulted from change controls

5. is it evident from the plan what work has been done

6. what are the planned activities for next period

7. for all items completed resulting in deliverables to the client

8. Has the client reviewed/accepted them, 

9. Tested them

10. Do they meet requirements/expectations

11. Have they been signed-off

12. have measurements been recorded

13. Effort planned v. effort used

14. Is there an explanation for the variances

15. Are the variances covered by change control or explained and/or accepted by client

16. are there any delays to the timetable and if so are they acceptable by the client (has he been informed)


Project Financials
1. current spend v budget

2. forecast spend v budget

3. identification of unplanned expenditure

4. what are the reasons for the over/under spend, unplanned expenditure


Contractual Position 

1. fixed price/T&M

2. deliverables/

3. penalties

4. Terms and Conditions

5. payment milestones.

6. Project Baseline

7. statement of requirements

8. objectives

9. proposal

10. clarification documentation



Technical
Environment/Special Requirements
1. hardware and network dependencies

2. number of sites

3. dependencies on other projects

4. interfaces to other systems

5. technically demanding requirements


Client Relationship
1. attitude to Consultant

2. attitude to the project

3. PM relationship

4.  client management

team relationships


Future
Next Months/Periods Activities

1. estimated to complete (revenue, cost and effort), risks, issues and actions

2. does the plan include all anticipated items to complete the assignment

3. are any items being added or deleted from the plan (using change control)

4. has any additional effort or cost been identified, measured and approved- are there any delivery date implications

5. have suitable resources been identified and allocated (including client)

6. are formal acceptance plans prepared.

7. what is acceptance based on

8. what is the strategy

9. have change controls been included in the acceptance plans/criteria

10. is pre-production planning and activity underway and is it available to the team

11. is training the client/transfer of information planned/in progress/complete

12. are the overall costs and delivery dates acceptable to the client and consultant





Questions for Executive Sponsor

1. Introductions

2. <Implementation/Project> Review Objectives
a)  
b)
c)

3. What drives partnership model at <Client Short Name>? 

4. What qualities were you looking for and how closely did you see the participants of the project deliver to your expectations?

5. How do you see the consulting organization assisting now and in the future?

6. What type of processes are in place to ensure CONTROL and delivery of specific projects?

Could this aspect of the project be improved?

7. Describe the benefits of <decentralized/centralized> project model and whether this model has met your expectations.

8. Describe communication within and between the IT organization and the business units.  

9. How do you know when your projects are succeeding or struggling?

10. At what levels can decisions be made?
a)  Business process changes?
b)  Purchasing and funding decisions?
c)  Implementation or project schedule?

11. IT Management - of all the projects that are on going where do you need the MOST support?

Is the consulting organization positioned to help drive those initiatives and projects? 

12. How do you measure success of these projects and implementations?

13. Do you have any specific concerns about any aspects of the consulting organization’s products, services, and relationship?

14. Service competency - what you do see as strengths and weaknesses of the consulting organization’s Resources

15. What are you key decision criteria in distributing work among internal staff, the consulting organization, and 3rd party contractors? 

16. What are the key ingredients of <Client Short Name>‘s system solution?

17. How much influence do you see the <type of products> products have on the consulting organization?

18. What future opportunities are you excited about (Web Server, Data Warehousing)?

How can the consulting organization help you determine how this new technology would fit your business?

19. What actions do you see the consulting organization taking to make <Client Short Name> a showcase?

20. Is <Client Short Name> prepared to influence <level of change - dramatic> change by:
a) implementing structure, 
b) instituting processes, and 
c) establishing leadership?

21. What extended role do you see for the consulting organization in each of these areas?

22. As you look at the communication efforts to date, of which are you particularly proud?  What needs improvement?

23. What aspects of the sponsorship of this project do you feel are particularly effective?  Ineffective?

24. What evidence of resistance to this project are you seeing?  What evidence of buy in?

Questions for IT Project Management 

1. Introductions

2. <Implementation/Project> Review Objectives
a)  
b)
c)

3. Describe your role and responsibilities.

4. How well do the <Applications or Tools> FIT your needs?

5. Discuss the role and importance of each of the partners on the various <Client Short Name> projects.

6. International Requirements Management.

7. International Implementation Management.

8. Future work

9. Processes in place -- control, infrastructure

10. Planning technique and approach

11. Communication 

12. Showcase Model

13. How would you evaluate the acceptance of the new technology in the organization?

14. Are you getting the sponsorship you need for the project?

15. How much do the stakeholders (people who have a vested interest in the project) know about the benefits of the new technology?  Are they up to date on the progress?

Questions for Project Managers

1.  
What is your role and principle functions?

2. Who(m) is your primary customer?  To whom do you answer?

3. Length of time on project?

4. General status of the project?

5. Top 3-5 positives

6. Top 3-5 concerns

7. Do you see any weaknesses in the processes being followed?

8. Do you see any weaknesses in the people or teams?

9. How would you evaluate the team’s ability to meet <production date> of <Date>?

10. What’s your contribution to meeting this delivery date?

11. Do you expect a complete success?  What level and why?

12. What then would make this project successful in your mind?

13. Is this perception different from the status quo or other management?

14. What are critical success factors for the <Client Short Name>?

15. How do you interact with other groups?

16. Is this relationship effective and are there specific things that you would like to see conducted differently?

17. Do you recognize any areas of vulnerability or exposure for the <Client Short Name>?

18. What would you recommend that the consulting organization do to improve  services, add value to the project, and set expectations?

19. What kind of management support are you getting for the project?

20. How would you evaluate the communication of the project vision and the progress to date?

21. What is the general reaction to the project among the stakeholders?  Are there any symptoms of resistance?
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